Table of Contents

Chapter 1: Introduction ................................................................. 4
  Features .................................................................................. 4
  IP Facts ............................................................................... 5

Chapter 2: Overview ................................................................. 6
  Feature Summary ................................................................... 6
  Licensing and Ordering ......................................................... 7

Chapter 3: Product Specification ............................................... 8
  Standards ............................................................................... 8
  Performance .......................................................................... 8
  Resource Use ......................................................................... 9
  Port Descriptions .................................................................... 9
  Register Space ....................................................................... 11

Chapter 4: Designing with the Core .......................................... 13
  Clocking ................................................................................ 13
  Resets ................................................................................. 13
  Protocol Description ............................................................ 13

Chapter 5: Design Flow Steps ................................................... 14
  Customizing and Generating the Core .................................... 14
  Constraining the Core ......................................................... 18
  Simulation ............................................................................. 19
  Synthesis and Implementation ............................................. 19

Appendix A: Upgrading ............................................................. 20
  Migrating to the Vivado Design Suite .................................... 20
  Upgrading in the Vivado Design Suite ................................... 20

Appendix B: Debugging ............................................................. 21
  Finding Help on Xilinx.com ................................................. 21
Chapter 1

Introduction

In a multi-processor environment, the processors share common resources. The Mutex core provides a mechanism for mutual exclusion to enable one process to gain exclusive access to a particular resource.

The Mutex core contains a configurable number of mutexes. Each of these can be associated with a 32-bit user configuration register to store arbitrary data.

Features

- Supports AXI4-Lite
- Configurable number of AXI4-Lite interfaces from 0 to 8
- Configurable asynchronous or synchronous interface operation
- Configurable USER register
- Configurable number of mutexes
- Configurable CPUID width
- Configurable enhanced security through hardware identification support
## IP Facts

### LogiCORE™ IP Facts Table

<table>
<thead>
<tr>
<th>Core Specifics</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported Device Family¹</td>
<td>UltraScale™, UltraScale Architecture, Zynq®-7000, 7 series</td>
</tr>
<tr>
<td>Supported User Interfaces</td>
<td>AXI4-Lite</td>
</tr>
<tr>
<td>Resources</td>
<td>Performance and Resource Use web page</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Provided with Core</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Files</td>
<td>Vivado® RTL</td>
</tr>
<tr>
<td>Example Design</td>
<td>Not Provided</td>
</tr>
<tr>
<td>Test Bench</td>
<td>Not Provided</td>
</tr>
<tr>
<td>Constraints File</td>
<td>N/A</td>
</tr>
<tr>
<td>Simulation Model</td>
<td>VHDL Behavioral</td>
</tr>
<tr>
<td>Supported S/W Driver²</td>
<td>Standalone</td>
</tr>
</tbody>
</table>

### Tested Design Flows³

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Entry</td>
<td>Vivado® Design Suite</td>
</tr>
<tr>
<td>Simulation</td>
<td>For supported simulators, see the Xilinx Design Tools: Release Notes Guide.</td>
</tr>
<tr>
<td>Synthesis</td>
<td>Vivado Synthesis</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Support</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Release Notes and Known Issues</td>
<td>Master Answer Record: 54409</td>
</tr>
<tr>
<td>All Vivado IP Change Logs</td>
<td>Master Vivado IP Change Logs: 72775</td>
</tr>
</tbody>
</table>

### Xilinx Support web page

**Notes:**

1. For a complete list of supported devices, see the Vivado® IP catalog.
2. Standalone driver details can be found in `<Install Directory>/Vitis/<release>/data/embeddedsw/doc/xilinx_drivers.htm`. BareMetal driver support information is available from the BareMetal Mutex Driver Page.
3. For the supported versions of third-party tools, see the Xilinx Design Tools: Release Notes Guide.
Overview

The Mutex core contains a configurable number of mutexes. Each mutex can be associated with a 32-bit user configuration register to store arbitrary data.

In a multi-processor environment, the processors share common resources. The mutex provides a mechanism for mutual exclusion to enable one process to gain exclusive access to a particular resource.

The Mutex core in a typical AXI4-Lite system is shown in the top-level block diagram in the following figure.

Figure 1: Mutex Core in an AXI4-Lite System

Feature Summary

Bus Interfaces

The Mutex core has two bus interfaces to access the internal resources, usually connected to different processors in a multi-processor system.
Registers

The Mutex core provides several types of registers, available with AXI4-Lite interfaces:

- Mutex core registers, which provides the possibility to lock and release the mutex.
- User configuration registers.

Protection

The Mutex core provides hardware tamper-proof protection of mutex access, preventing any processor except the intended one from modifying a mutex.

Licensing and Ordering

This Xilinx® LogiCORE™ IP module is provided at no additional cost with the Xilinx Vivado® Design Suite under the terms of the Xilinx End User License.

Information about other Xilinx® LogiCORE™ IP modules is available at the Xilinx Intellectual Property page. For information about pricing and availability of other Xilinx® LogiCORE IP modules and tools, contact your local Xilinx sales representative.

License Checkers

If the IP requires a license key, the key must be verified. The Vivado® design tools have several license checkpoints for gating licensed IP through the flow. If the license check succeeds, the IP can continue generation. Otherwise, generation halts with an error. License checkpoints are enforced by the following tools:

- Vivado Synthesis
- Vivado Implementation
- write_bitstream (Tcl command)

**IMPORTANT! IP license level is ignored at checkpoints. The test confirms a valid license exists. It does not check IP license level.**
Product Specification

Standards

This Mutex adheres to the AXI4-Lite standard defined in the Arm® AMBA® AXI and ACE Protocol Specification (IHI0022E).

Performance

The frequency and latency of the Mutex core are optimized for use with MicroBlaze™. This means that the frequency targets are aligned to MicroBlaze targets.

Maximum Frequencies

For details about performance, visit Performance and Resource Utilization.

Latency and Throughput

The latency and throughput of accesses to the Mutex core depends on the bus interface. The latency for each interface when reading or writing, as well as the throughput, is shown in the following table, according to the parameter settings affecting the measurements.

<table>
<thead>
<tr>
<th>Bus Interface</th>
<th>Read Latency (clock cycles)</th>
<th>Write Latency (clock cycles)</th>
<th>Throughput (clock cycles/word)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synchronous (C_ASYNC_CLKS = 0)</td>
<td>3</td>
<td>3</td>
<td>6</td>
</tr>
<tr>
<td>AXI4-Lite</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Asynchronous (C_ASYNC_CLKS = 1)</td>
<td>3</td>
<td>3</td>
<td>10</td>
</tr>
<tr>
<td>AXI4-Lite</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Resource Use

For full details about performance and resource use, visit the Performance and Resource Use web page.

Port Descriptions

The Mutex core supports AXI4-Lite interfaces, and the number of interfaces is independently configured from 0 to 8. All interfaces are individually configured and contain the signals listed in the following table, where \(<x>\) denotes the interface number (0 to 7).

**AXI4-Lite Interface Ports**

**Table 2: I/O Signal Description for AXI4-Lite Interface**

<table>
<thead>
<tr>
<th>Port</th>
<th>Signal Name</th>
<th>Interface</th>
<th>I/O</th>
<th>Initial State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>System Signals</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>P43</td>
<td>S&lt;&gt;&gt;.AXI_ACLK</td>
<td>System</td>
<td>I</td>
<td>-</td>
<td>AXI clock</td>
</tr>
<tr>
<td>P44</td>
<td>S&lt;&gt;&gt;.AXI_ARESETN</td>
<td>System</td>
<td>I</td>
<td>-</td>
<td>AXI reset, active-Low</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>AXI Write Address Channel Signals</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>P45</td>
<td>S&lt;&gt;&gt;.AXI_AWADDR[C_S&lt;&gt;&gt;.AXI_ADDR_WIDTH-1:0]</td>
<td>AXI</td>
<td>I</td>
<td>-</td>
<td>AXI write address. The write address bus gives the address of the write transaction.</td>
</tr>
<tr>
<td>P46</td>
<td>S&lt;&gt;&gt;.AXI_AWVALID</td>
<td>AXI</td>
<td>I</td>
<td>-</td>
<td>Write address valid. This signal indicates that valid write address is available.</td>
</tr>
<tr>
<td>P47</td>
<td>S&lt;&gt;&gt;.AXI_AWREADY</td>
<td>AXI</td>
<td>O</td>
<td>0</td>
<td>Write address ready. This signal indicates that the slave is ready to accept an address.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>AXI Write Channel Signals</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>P48</td>
<td>S&lt;&gt;&gt;.AXI_WDATA[C_S&lt;&gt;&gt;.AXI_DATA_WIDTH-1:0]</td>
<td>AXI</td>
<td>I</td>
<td>-</td>
<td>Write data</td>
</tr>
<tr>
<td>P49</td>
<td>S&lt;&gt;&gt;.AXI_WSTB[C_S&lt;&gt;&gt;.AXI_DATA_WIDTH/8-1:0]</td>
<td>AXI</td>
<td>I</td>
<td>-</td>
<td>Write strobes. This signal indicates which byte lanes to update in memory[1]</td>
</tr>
<tr>
<td>P50</td>
<td>S&lt;&gt;&gt;.AXI_WVALID</td>
<td>AXI</td>
<td>I</td>
<td>-</td>
<td>Write valid. This signal indicates that valid write data and strobes are available.</td>
</tr>
<tr>
<td>P51</td>
<td>S&lt;&gt;&gt;.AXI_WREADY</td>
<td>AXI</td>
<td>O</td>
<td>0</td>
<td>Write ready. This signal indicates that the slave can accept the write data.</td>
</tr>
</tbody>
</table>
### Table 2: I/O Signal Description for AXI4-Lite Interface (cont’d)

<table>
<thead>
<tr>
<th>Port</th>
<th>Signal Name</th>
<th>Interface</th>
<th>I/O</th>
<th>Initial State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>AXI Write Response Channel Signals</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>P52</td>
<td>S&lt;x&gt;_AXI_BRESP[1:0]</td>
<td>AXI</td>
<td>O</td>
<td>0x0</td>
<td>Write response. This signal indicates the status of the write transaction.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>00 - OKAY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>10 - SLVERR</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>11 - DECERR</td>
</tr>
<tr>
<td>P53</td>
<td>S&lt;x&gt;_AXI_BVALID</td>
<td>AXI</td>
<td>O</td>
<td>0</td>
<td>Write response valid. This signal indicates that a valid write response is available.</td>
</tr>
<tr>
<td>P54</td>
<td>S&lt;x&gt;_AXI_BREADY</td>
<td>AXI</td>
<td>I</td>
<td>?</td>
<td>Response ready. This signal indicates that the master can accept the response information.</td>
</tr>
<tr>
<td></td>
<td>AXI Read Address Channel Signals</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>P55</td>
<td>S&lt;x&gt;_AXI_ARADDR[C_S&lt;x&gt;_AXI_ADDR_WIDTH-1:0]</td>
<td>AXI</td>
<td>I</td>
<td>?</td>
<td>Read address. The read address bus gives the address of a read transaction.</td>
</tr>
<tr>
<td>P56</td>
<td>S&lt;x&gt;_AXI_ARVALID</td>
<td>AXI</td>
<td>I</td>
<td>?</td>
<td>Read address valid. This signal indicates, when High, that the read address is valid and remains stable until the address acknowledge signal, S&lt;x&gt;_AXI_ARREADY, is High.</td>
</tr>
<tr>
<td>P57</td>
<td>S&lt;x&gt;_AXI_ARREADY</td>
<td>AXI</td>
<td>O</td>
<td>1</td>
<td>Read address ready. This signal indicates that the slave is ready to accept an address.</td>
</tr>
<tr>
<td></td>
<td>AXI Read Data Channel Signals</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>P58</td>
<td>S&lt;x&gt;_AXI_RDATA[C_S&lt;x&gt;_AXI_DATA_WIDTH-1:0]</td>
<td>AXI</td>
<td>O</td>
<td>0x0</td>
<td>Read data</td>
</tr>
<tr>
<td>P59</td>
<td>S&lt;x&gt;_AXI_RRESP[1:0]</td>
<td>AXI</td>
<td>O</td>
<td>0x0</td>
<td>Read response. This signal indicates the status of the read transfer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>00 - OKAY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>10 - SLVERR</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>11 - DECERR</td>
</tr>
<tr>
<td>P60</td>
<td>S&lt;x&gt;_AXI_RVALID</td>
<td>AXI</td>
<td>O</td>
<td>0</td>
<td>Read valid. This signal indicates that the required read data is available and the read transfer can complete.</td>
</tr>
<tr>
<td>P61</td>
<td>S&lt;x&gt;_AXI_RREADY</td>
<td>AXI</td>
<td>I</td>
<td>?</td>
<td>Read ready. This signal indicates that the master can accept the read data and response information.</td>
</tr>
</tbody>
</table>

**Notes:**
1. This signal is not used. The Mutex core assumes that all byte lanes are active.
Register Space

Each interface of the Mutex core can access all mutexes. Only one interface at the time can access any of the mutexes. For example, while one interface is accessing any of the mutexes, all other AXI interfaces are blocked. Interface arbitration has fixed priority for AXI 0-7 in descending order. For example, S0_AXI has the highest priority, and S7_AXI the lowest. When configured with multiple mutexes each reserves a 256 byte address range, that is, registers for mutex #0 is located between 0x0 and 0xFF, mutex #1 between 0x100 and 0x1FF and so on. The following table shows all the Mutex core registers and their addresses offsets for each available Mutex.

Table 3: Mutex Registers

<table>
<thead>
<tr>
<th>Base Address + Offset (hex)</th>
<th>Register Name</th>
<th>Access Type</th>
<th>Default Value (hex)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BASEADDR + 0x0</td>
<td>MUTEX</td>
<td>R/W</td>
<td>0</td>
<td>Mutex register for mutex ownership</td>
</tr>
<tr>
<td>BASEADDR + 0x4</td>
<td>USER</td>
<td>N/A</td>
<td>0</td>
<td>USER configuration register</td>
</tr>
<tr>
<td>BASEADDR + 0x8 to 0xFC</td>
<td>Reserved</td>
<td></td>
<td></td>
<td>Reserved for future use</td>
</tr>
</tbody>
</table>

Mutex Register (MUTEX)

The MUTEX register contains one mandatory and two optional bit fields. The LOCK bit is required because this bit determines if the mutex is in the locked or released state. CPUID is usually included to control access of who can manipulate the mutex. It is only the owner of the mutex that can release it. For extra safety, an optional HWID field is also available. The HWID bits are not user-accessible and are handled implicitly in the background. HWID contains which port the AXI master is attached. This guarantees that no other processor can fake the CPUID and gain access over the mutex. Bit assignment in the MUTEX register is described in Table 5: Write Data Register Bit Definitions.

CPUID is a unique identification value assigned by the tools to the software that executes on each processor. Because the CPUID is only assigned to software created from within the Vitis™ unified software platform, any other master that accesses the mutex must be manually assigned a unique number that does not interfere with the others. Examples of this are external processors and hardware IPs other than the MicroBlaze™ processor. Each processor has its allocated CPUID listed in xparameters.h.

Mutex Lock and Release Process

The steps required to lock and release a mutex (for a free mutex, the MUTEX register is zero):
• Write \(<\text{CPUID} \& 1>\) to the MUTEX register. If the mutex is free, the lock bit is set to one and the CPUID field is updated with the new CPUID. If C_ENABLE_HW_PROT is enabled, the HWID is also stored for enhanced protection. If the mutex is already locked, the access is ignored.

• Read back the MUTEX register to verify that the mutex has been locked by the current CPU by comparing the value with the written CPUID. If not, retry step 1 until ownership has been granted.

• Manipulate the shared resource that is protected by the mutex.

• Release the mutex by writing \(<\text{CPUID} \& 0>\) to the MUTEX register. If C_ENABLE_HW_PROT is enabled, the HWID is also taken into account. The mutex automatically sets the MUTEX register to zero.

If the “wrong” processor attempts to free the mutex with C_ENABLE_HW_PROT active and with the correct CPUID the operation is ignored because both the HWID and CPUID must match for the operation to be successful. Also, the operation is ignored if the “right” processor writes the wrong CPUID.

<table>
<thead>
<tr>
<th>Bit(s)</th>
<th>Name</th>
<th>Core Access</th>
<th>Reset Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>31-9</td>
<td>Reserved</td>
<td>N/A</td>
<td>-</td>
<td>Reserved for future use.</td>
</tr>
<tr>
<td>8-1</td>
<td>CPUID</td>
<td>R/W</td>
<td>-</td>
<td>Unique processor ID number.</td>
</tr>
<tr>
<td>0</td>
<td>LOCK</td>
<td>R/W</td>
<td>0</td>
<td>Lock status: 0 = free, 1 = Mutex currently owned by CPUID.</td>
</tr>
</tbody>
</table>

Table 5: Write Data Register Bit Definitions

Mutex User Configuration Register (USER)

The USER configuration is used to store a 32-bit value associated with a Mutex. It can contain any arbitrary information. Bit assignment in the USER register is described in the following table.

<table>
<thead>
<tr>
<th>Bit(s)</th>
<th>Name</th>
<th>Core Access</th>
<th>Reset Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>31</td>
<td>USER</td>
<td>R/W</td>
<td>-</td>
<td>User configuration register</td>
</tr>
</tbody>
</table>

Table 7: Mutex Read Data Register Bit Definitions
Designing with the Core

This section includes guidelines and additional information to facilitate designing with the core.

Clocking

The \texttt{Sn\_AXI\_ACLK} (n = 0 - 7) input should normally be connected to the same clock as the interconnect. With synchronous operation (\texttt{C\_ASYNC\_CLKS} = 0), the clock inputs used must all be connected to this same clock signal.

Resets

The \texttt{Sn\_AXI\_ARESETN} (n = 0 - 7) input should normally be connected to the same reset as the interconnect.

Protocol Description

See the Arm® AMBA® AXI and ACE Protocol Specification (IHI0022E).
Design Flow Steps

This section describes customizing and generating the core, constraining the core, and the simulation, synthesis, and implementation steps that are specific to this IP core. More detailed information about the standard Vivado® design flows and the IP integrator can be found in the following Vivado Design Suite user guides:

- **Vivado Design Suite User Guide: Designing with IP (UG896)**

Customizing and Generating the Core

This section includes information about using Xilinx® tools to customize and generate the core in the Vivado® Design Suite.

If you are customizing and generating the core in the Vivado IP integrator, see the **Vivado Design Suite User Guide: Designing IP Subsystems using IP Integrator (UG994)** for detailed information. IP integrator might auto-compute certain configuration values when validating or generating the design. To check whether the values do change, see the description of the parameter in this chapter. To view the parameter value, run the `validate_bd_design` command in the Tcl console.

You can customize the IP for use in your design by specifying values for the various parameters associated with the IP core using the following steps:

1. Select the IP from the IP catalog.
2. Double-click the selected IP or select the Customize IP command from the toolbar or right-click menu.

For details, see the **Vivado Design Suite User Guide: Designing with IP (UG896)** and the **Vivado Design Suite User Guide: Getting Started (UG910)**.

Figures in this chapter are illustrations of the Vivado IDE. The layout depicted here might vary from the current version.
There are two tabs in Vivado IDE core configuration screen, User and Clocks. The User screen is divided in two categories: System and Mutex. When using the Vivado IP integrator feature, the addresses are auto-generated.

**User Tab Configuration**

The User tab configuration screen is shown in the following figure.

*Figure 2: User Tab Configuration*

- **Number of Available AXI4-Lite Interfaces**: Sets the number of available bus interfaces, typically one interface per connected processor.
- **Use Asynchronous Operation for the Interfaces**: Enables asynchronous operation, when the clocks of the used interfaces are not identical.
- **Number of Mutexes**: Defines how many individual mutexes are available.
- **Enable 32-bit USER Register**: The USER register can be used to store arbitrary data. Usually it stores the address to the shared resource controlled by the Mutex.
Enable Hardware Protection: When hardware protection is enabled, HWID is used to complement the CPUID for enhanced security. The HWID consists of the AXI interface number and AXI transaction ID for the processor that has locked the Mutex. The HWID is not user-accessible and is thus tamper proof.

Clocks Tab Configuration

The Clocks tab configuration screen is shown in the following figure.

**Figure 3: Clocks Tab Configuration Screen**

- Sn_AXI_ACLK frequency (MHz): Sets the frequency for the input clock (n = 0–7).

Parameter Values

The Mutex design is parameterized to tailor it for different systems. This allows you to configure a design that uses the resources required by the system only and that operates with the best possible performance. The features that can be parameterized in the Mutex design are shown in the following table.
**Table 8: Design Parameters**

<table>
<thead>
<tr>
<th>Generic</th>
<th>Feature/Description</th>
<th>Parameter Name</th>
<th>Allowable Values</th>
<th>Default Value</th>
<th>VHDL Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Parameter</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>G1</td>
<td>Target FPGA family</td>
<td>C_FAMILY</td>
<td>Supported architectures</td>
<td>virtue7</td>
<td>string</td>
</tr>
<tr>
<td>Mutex Parameters</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>G17</td>
<td>Specify if interfaces are synchronous or asynchronous</td>
<td>C_ASYNC_CLKS</td>
<td>0-1</td>
<td>0</td>
<td>integer</td>
</tr>
<tr>
<td>G18</td>
<td>Number of synchronization FF for each clock domain crossing. All interfaces except S0_AXI have an additional latency of C_NUM_SYNC_FF S0_AXI clock cycles plus C_NUM_SYNC_FF clock cycles for the local Sx_AXI interface.</td>
<td>C_NUM_SYNC_FF</td>
<td>1-8</td>
<td>2</td>
<td>integer</td>
</tr>
<tr>
<td>G19</td>
<td>Number of AXI4-Lite interfaces</td>
<td>C_NUM_AXI</td>
<td>0-8</td>
<td>0</td>
<td>integer</td>
</tr>
<tr>
<td>G20</td>
<td>If the 32-bit USER register associated with a mutex should be available</td>
<td>C_ENABLE_USER</td>
<td>0-1</td>
<td>32</td>
<td>integer</td>
</tr>
<tr>
<td>G21</td>
<td>Number of bits used for the CPUID field</td>
<td>C_OWNER_ID_WIDTH</td>
<td>8</td>
<td>8</td>
<td>integer</td>
</tr>
<tr>
<td>G22</td>
<td>If hardware protection of a mutex should be enabled besides the CPUID (if available)</td>
<td>C_ENABLE_HW_PROT</td>
<td>0-1</td>
<td>0</td>
<td>integer</td>
</tr>
<tr>
<td>G23</td>
<td>Number of mutexes that are contained inside the core</td>
<td>C_NUM_MUTEX</td>
<td>1-32</td>
<td>16</td>
<td>integer</td>
</tr>
</tbody>
</table>

**User Parameters**

The following table shows the relationship between the fields in the Vivado® IDE and the user parameters (which can be viewed in the Tcl Console).

**Table 9: User Parameters**

<table>
<thead>
<tr>
<th>Vivado IDE Parameter/Value</th>
<th>User Parameter/Value</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Available AXI4-Lite Interfaces</td>
<td>C_NUM_AXI</td>
<td>2</td>
</tr>
<tr>
<td>Use Asynchronous Operation for the Interfaces</td>
<td>C_ASYNC_CLKS</td>
<td>0</td>
</tr>
<tr>
<td>Number of Mutexes</td>
<td>C_NUM_MUTEX</td>
<td>16</td>
</tr>
<tr>
<td>Enable 32-bit USER Register</td>
<td>C_ENABLE_USER</td>
<td>0</td>
</tr>
<tr>
<td>Enable Hardware Protection</td>
<td>C_ENABLE_HW_PROT</td>
<td>0</td>
</tr>
<tr>
<td>Sn_AXI_ACLK frequency (MHz)(^1)</td>
<td>Sn_AXI_ACLK_FREQ_MHZ</td>
<td>100.0</td>
</tr>
</tbody>
</table>

**Notes:**
1. \(n=0-7\)
Constraining the Core

This section contains information about constraining the core in the Vivado® Design Suite.

**Required Constraints**
This section is not applicable for this IP core.

**Device, Package, and Speed Grade Selections**
This section is not applicable for this IP core.

**Clock Frequencies**
This section is not applicable for this IP core.

**Clock Management**
The Mutex core can either be fully synchronous with all clocked elements clocked by the same physical clock, or asynchronous with different clocks on the connected bus interfaces.

With an asynchronous configuration, the parameter C_ASYNC_CLKS (Use Asynchronous Operation for the Interfaces) must be set manually.

To operate properly when connected to MicroBlaze™, the corresponding bus interface clock must be the same as the MicroBlaze CCLK.

**Clock Placement**
This section is not applicable for this IP core.

**Banking**
This section is not applicable for this IP core.

**Transceiver Placement**
This section is not applicable for this IP core.

**I/O Standard and Placement**
This section is not applicable for this IP core.
Simulation

For comprehensive information about Vivado® simulation components, as well as information about using supported third-party tools, see the *Vivado Design Suite User Guide: Logic Simulation* (UG900).

Synthesis and Implementation

For details about synthesis and implementation, see the *Vivado Design Suite User Guide: Designing with IP* (UG896).
Appendix A

Upgrading

This appendix contains information about migrating a design from the ISE® Design Suite to the Vivado® Design Suite, and for upgrading to a more recent version of the IP core. For customers upgrading in the Vivado Design Suite, important details (where applicable) about any port changes and other impact to user logic are included.

Migrating to the Vivado Design Suite

For information about migrating to the Vivado Design Suite, see the *ISE to Vivado Design Suite Migration Guide (UG911).*

Upgrading in the Vivado Design Suite

This section provides information about any changes to the user logic or port designations that take place when you upgrade to a more current version of this IP core in the Vivado Design Suite.
Debugging

This appendix includes details about resources available on the Xilinx® Support website and debugging tools.

If the IP requires a license key, the key must be verified. The Vivado® design tools have several license checkpoints for gating licensed IP through the flow. If the license check succeeds, the IP can continue generation. Otherwise, generation halts with an error. License checkpoints are enforced by the following tools:

- Vivado Synthesis
- Vivado Implementation
- write_bitstream (Tcl command)

⭐ IMPORTANT! IP license level is ignored at checkpoints. The test confirms a valid license exists. It does not check IP license level.

Finding Help on Xilinx.com

To help in the design and debug process when using the core, the Xilinx Support web page contains key resources such as product documentation, release notes, answer records, information about known issues, and links for obtaining further product support. The Xilinx Community Forums are also available where members can learn, participate, share, and ask questions about Xilinx solutions.

Documentation

This product guide is the main document associated with the core. This guide, along with documentation related to all products that aid in the design process, can be found on the Xilinx Support web page or by using the Xilinx® Documentation Navigator. Download the Xilinx Documentation Navigator from the Downloads page. For more information about this tool and the features available, open the online help after installation.
Answer Records

Answer Records include information about commonly encountered problems, helpful information on how to resolve these problems, and any known issues with a Xilinx product. Answer Records are created and maintained daily ensuring that users have access to the most accurate information available.

Answer Records for this core can be located by using the Search Support box on the main Xilinx support web page. To maximize your search results, use keywords such as:

- Product name
- Tool message(s)
- Summary of the issue encountered

A filter search is available after results are returned to further target the results.

**Master Answer Record for the Core**

AR 54409.

Technical Support

Xilinx provides technical support on the Xilinx Community Forums for this LogiCORE™ IP product when used as described in the product documentation. Xilinx cannot guarantee timing, functionality, or support if you do any of the following:

- Implement the solution in devices that are not defined in the documentation.
- Customize the solution beyond that allowed in the product documentation.
- Change any section of the design labeled DO NOT MODIFY.

To ask questions, navigate to the Xilinx Community Forums.

---

Debug Tools

There are many tools available to address Mutex design issues. It is important to know which tools are useful for debugging various situations.
Vivado Design Suite Debug Feature

The Vivado® Design Suite debug feature inserts logic analyzer and virtual I/O cores directly into your design. The debug feature also allows you to set trigger conditions to capture application and integrated block port signals in hardware. Captured signals can then be analyzed. This feature in the Vivado IDE is used for logic debugging and validation of a design running in Xilinx® devices.

The Vivado logic analyzer is used to interact with the logic debug LogiCORE IP cores, including:

- ILA 2.0 (and later versions)
- VIO 2.0 (and later versions)

See the Vivado Design Suite User Guide: Programming and Debugging (UG908).

Reference Boards

All Xilinx® development boards support the Mutex core. These boards can be used to prototype designs and establish that the core can communicate with the system.

Simulation Debug

The simulation debug flow for Mentor Graphics Questa Advanced Simulator is described below. A similar approach can be used with other simulators.

- Check for the latest supported versions of Questa Advanced Simulator in the Xilinx Design Tools: Release Notes Guide.
- If using Verilog, do you have a mixed mode simulation license? If not, obtain a mixed-mode license.
- Ensure that the proper libraries are compiled and mapped. In the Vivado® Design Suite Flow → Simulation Settings can be used to define the libraries.
- Have you associated the intended software program for the MicroBlaze™ processor with the simulation? Use the command Tools → Associate ELF Files in Vivado Design Suite.
- When observing the traffic on the interfaces connected to the Mutex core, see the timing in the relevant specification:
  - For AXI4-Lite see the Arm® AMBA® AXI and ACE Protocol Specification (IHI0022E).
Hardware Debug

Hardware issues can range from link bring-up to problems seen after hours of testing. This section provides debug steps for common issues. The Vivado® debug feature is a valuable resource to use in hardware debug. The signal names mentioned in the following individual sections can be probed using the debug feature for debugging the specific problems.

Many of these common issues can also be applied to debugging design simulations.

General Checks

Ensure that all the timing constraints for the core were properly incorporated from the example design and that all constraints were met during implementation.

- Does it work in post-place and route timing simulation? If problems are seen in hardware but not in timing simulation, this could indicate a PCB issue. Ensure that all clock sources are active and clean.
- If using MMCMs in the design, ensure that all MMCMs have obtained lock by monitoring the locked port.
- If your outputs go to 0, check your licensing.

Interface Debug

AXI4-Lite Interfaces

Read from a register that does not have all 0s as a default to verify that the interface is functional. Output Sn AXI ARREADY asserts when the read address is valid, and output Sn AXI RVALID asserts when the read data/response is valid, where n is the interface number (0 or 1). If the interface is unresponsive, ensure that the following conditions are met:

- The Sn AXI ACLK input is connected and toggling.
- The interface is not being held in reset, and Sn AXI ARESEN is an active-Low reset.
- The common core reset is not active, and SYS Rst is an active-High reset.
- If the simulation has been run, verify in simulation and/or the Vivado debug feature capture that the waveform is correct for accessing the AXI4-Lite interface.
Application Software Development

Device Drivers

The Mutex core is supported by the mutex driver, included with the Xilinx® Vitis™ unified software platform.
Appendix D

Additional Resources and Legal Notices

Xilinx Resources

For support resources such as Answers, Documentation, Downloads, and Forums, see Xilinx Support.

Documentation Navigator and Design Hubs

Xilinx® Documentation Navigator (DocNav) provides access to Xilinx documents, videos, and support resources, which you can filter and search to find information. To open DocNav:

- From the Vivado® IDE, select Help → Documentation and Tutorials.
- On Windows, select Start → All Programs → Xilinx Design Tools → DocNav.
- At the Linux command prompt, enter docnav.

Xilinx Design Hubs provide links to documentation organized by design tasks and other topics, which you can use to learn key concepts and address frequently asked questions. To access the Design Hubs:

- In DocNav, click the Design Hubs View tab.
- On the Xilinx website, see the Design Hubs page.

Note: For more information on DocNav, see the Documentation Navigator page on the Xilinx website.

References

These documents provide supplemental material useful with this guide:
6. ISE to Vivado Design Suite Migration Guide (UG911)

## Revision History

The following table shows the revision history for this document.

<table>
<thead>
<tr>
<th>Section</th>
<th>Revision Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>11/21/2019 Version 2.1</td>
</tr>
<tr>
<td>General Updates</td>
<td>Replaced SDK with Vitis™ software platform</td>
</tr>
<tr>
<td></td>
<td>11/18/2015 Version 2.1</td>
</tr>
<tr>
<td>General Updates</td>
<td>Added support for UltraScale+™</td>
</tr>
<tr>
<td></td>
<td>06/24/2015 Version 2.1</td>
</tr>
<tr>
<td>General Updates</td>
<td>Moved performance and resource utilization data to the web</td>
</tr>
<tr>
<td></td>
<td>04/02/2015 Version 2.1</td>
</tr>
<tr>
<td>General Updates</td>
<td>• Clarified address map when multiple mutexes are used.</td>
</tr>
<tr>
<td></td>
<td>• Added C_NUM_SYNC_FF parameter to control number of synchronization FF.</td>
</tr>
<tr>
<td></td>
<td>03/20/2013 Version 1.0</td>
</tr>
<tr>
<td>Initial release.</td>
<td>Initial release as a Product Guide; replaces PG089. There are no documentation changes for this release.</td>
</tr>
</tbody>
</table>

## Please Read: Important Legal Notices

The information disclosed to you hereunder (the "Materials") is provided solely for the selection and use of Xilinx products. To the maximum extent permitted by applicable law: (1) Materials are made available "AS IS" and with all faults, Xilinx hereby DISCLAIMS ALL WARRANTIES AND CONDITIONS, EXPRESS, IMPLIED, OR STATUTORY, INCLUDING BUT NOT LIMITED TO WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR ANY PARTICULAR PURPOSE; and (2) Xilinx shall not be liable (whether in contract or tort, including
negligence, or under any other theory of liability) for any loss or damage of any kind or nature related to, arising under, or in connection with, the Materials (including your use of the Materials), including for any direct, indirect, special, incidental, or consequential loss or damage (including loss of data, profits, goodwill, or any type of loss or damage suffered as a result of any action brought by a third party) even if such damage or loss was reasonably foreseeable or Xilinx had been advised of the possibility of the same. Xilinx assumes no obligation to correct any errors contained in the Materials or to notify you of updates to the Materials or to product specifications. You may not reproduce, modify, distribute, or publicly display the Materials without prior written consent. Certain products are subject to the terms and conditions of Xilinx's limited warranty, please refer to Xilinx's Terms of Sale which can be viewed at https://www.xilinx.com/legal.htm#tos; IP cores may be subject to warranty and support terms contained in a license issued to you by Xilinx. Xilinx products are not designed or intended to be fail-safe or for use in any application requiring fail-safe performance; you assume sole risk and liability for use of Xilinx products in such critical applications, please refer to Xilinx's Terms of Sale which can be viewed at https://www.xilinx.com/legal.htm#tos.

AUTOMOTIVE APPLICATIONS DISCLAIMER

AUTOMOTIVE PRODUCTS (IDENTIFIED AS "XA" IN THE PART NUMBER) ARE NOT WARRANTED FOR USE IN THE DEPLOYMENT OF AIRBAGS OR FOR USE IN APPLICATIONS THAT AFFECT CONTROL OF A VEHICLE ("SAFETY APPLICATION") UNLESS THERE IS A SAFETY CONCEPT OR REDUNDANCY FEATURE CONSISTENT WITH THE ISO 26262 AUTOMOTIVE SAFETY STANDARD ("SAFETY DESIGN"). CUSTOMER SHALL, PRIOR TO USING OR DISTRIBUTING ANY SYSTEMS THAT INCORPORATE PRODUCTS, THOROUGHLY TEST SUCH SYSTEMS FOR SAFETY PURPOSES. USE OF PRODUCTS IN A SAFETY APPLICATION WITHOUT A SAFETY DESIGN IS FULLY AT THE RISK OF CUSTOMER, SUBJECT ONLY TO APPLICABLE LAWS AND REGULATIONS GOVERNING LIMITATIONS ON PRODUCT LIABILITY.

Copyright

© Copyright 2013-2019 Xilinx, Inc. Xilinx, the Xilinx logo, Alveo, Artix, Kintex, Spartan, Versal, Virtex, Vivado, Zynq, and other designated brands included herein are trademarks of Xilinx in the United States and other countries. AMBA, AMBA Designer, Arm, ARM1176JZ-S, CoreSight, Cortex, PrimeCell, Mali, and MPCore are trademarks of Arm Limited in the EU and other countries. All other trademarks are the property of their respective owners.